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Copyright 

The activated software may only be used by the purchaser and utilized exclusively for the lessons or learning mate-
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Making the activation code available to colleagues at other schools or institutions is forbidden. 

The LD DIDACTIC GmbH company reserves the right to take legal action for violations of this rule. 
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Introduction 

This handbook is intended to provide an overview of the features available with SpectraLab software. Its text is iden-
tical to the program's online help facility, which is practically available anytime at a click of the mouse. 

Installation  

The installation process consists of two parts. 

a) Installation of the SpectraLab software 

The software installation is done either  

 automatically after inserting the CD-ROM or 

 manually by executing the setup.exe file 

then following the onscreen instructions. 

If necessary, the Microsoft .NET Framework 2.0 will be installed during this process. 

b) Installation of the spectrometer driver 

The spectrometer requires installation of a driver which is present on the CD in the subdirectory "Driver". After the 
spectrometer is connected to the PC, Windows will search for the driver on the CD by itself. 
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Compact spectrometer 

The compact spectrometer is used for computer aided recording of emission and absorption spectra. Light is admit-
ted by way of a freely movable fibre optic waveguide. 

Inside the spectrometer, the light is decomposed across a fixed grid and imposed on a silicon CCD array. Thus the 
intensity of all wavelengths is measured simultaneously so that even rapidly changing processes, such as flame 
colouration, can be recorded. 

The cuvette holder with built-in light source permits convenient investigation of the absorption spectra of liquid sub-
stances. 

For absorption measurements, a reference spectrum is first recorded then a spectrum with the absorbent to be inves-
tigated present in the beam path. From the relationship between these two spectra, the software calculates values 
like transmission, extinction and, after calibration, also concentration. 

Typical experiments include emission spectra, e.g. gas discharges, flame colourations, Fraunhofer lines in the sun's 
spectrum, Wien's displacement law, spectra of light emitting diodes or absorption spectra together with an external 
light source, e.g. photometry, reaction kinetics, absorption of filters, sodium vapours. 

In combination with a fibre holder (460 251), this spectrometer can also be utilized on an optical bench. 

Spectrometer technical data 

  467 251 or from 467 252 467 261 or from 467 262 

Setup: Czerny-Turner Czerny-Turner 
Detector: silicon CCD array silicon CCD array 
Wavelength range: 350 - 1000 nm 200 - 850 nm 
Resolution: 1 nm 1 nm 
Integration time: 3 - 1000 ms 3 - 1000 ms 
Computer connection: USB port USB port 
Voltage supply: USB port USB port 
Fibre connection: SMA 905 SMA 905 
Dimensions: 89 mm x 63 mm x 34 mm 89 mm x 63 mm x 34 mm 
Mass: 190 g 190 g 

Light source technical data 

  from 467 252 from 467 262 

Light source: tungsten incandescent bulb + blue LED  deuterium/tungsten 
Wavelength range: 390 - 1000 nm 200 - 850 nm 
Computer connection: via spectrometer via spectrometer 
Voltage supply: via spectrometer from separate power adapter 

(included in delivery complement) 
Dimensions: 89 mm x 41 mm x 34 mm  89 mm x 78 mm x 34 mm 
Mass: 130 g 200 g 

Delivery complement 

1 Spectrometer 
1 Software 
1 Fibre optic waveguide 
1 Cuvette holder with light source (only included with 467 252 and 467 262) 

Accessories 

Fibre holder (460 251) 
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SpectraLab 

  Experiment examples  

Introduction 

SpectraLab supports compact spectrometers (467 251, 467 252, 467 261 and 467 262) as well as the Ocean Optics 
USB650 / USB2000. 

Activation code 

A 24-character activation code is necessary to utilize SpectraLab software. This activation code is to be found on the 
bill of delivery and the invoice under the number 467 250. The activation code must be entered once, together with 
the name specified there. Afterwards the software is released for use. Please take note of our copyright. 

If your activation code is missing, please send a fax of the invoice for the compact spectrometer (467 251, 467 252, 
467 261 or 467 262) or the SpectraLab software (467 250) to +49-2233-604607. Your activation code will sent to you 
via return fax as soon as possible. 

Future versions, such as updates available for downloading on the Internet, will also use this activation code. This 
means that there are no restrictions on the use of updates. 

Measuring the first spectrum 

If a spectrometer is detected when the activated software is started or a spectrometer is connected to the computer 
after the software is started, the currently measured spectra will be displayed automatically. 

These spectra are already calibrated with respect to wavelength (x-axis). However, displayed intensities (y-axis) de-
pend on a number of factors. 

, 
  Integration time (shorter times → smaller intensities, longer times → larger intensities) 
  Light source (if an connected light source is being used, it can be switched on) 
  Additional settings 

Other settings, such as Offset or Reference measurement, are selectable from within various displays equipped with 
tab cards: 

 Offset I0 

 Intensity I1 = I-I0 

 Reference I2 = I-I0 

 Transmission T = I1/I2 

 Extinction E = -log(I1/I2) 

 Calibration 

 Kinetics 

If displays for Transmission/Loss or Relative Intensity are selected via  Settings → Additional Settings then the 
supplementary displays 

 Loss a 

or 

 Spectrometer sensitivity I2 

 Relative intensity I3 = I1/I2 

become available. 
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Basic functions can be executed directly by way of the main menu and tool buttons  : 

File    Spectrum    Settings    Table    Diagram    Kinetics    Help 

Beneath the menu and toolbar, mouse click operations can be used to change between tabbed display panels , the 
table display  and the diagram . The amount of display space allocated to the table and diagram can be shifted 
by dragging the partition line  with the mouse. 

In many situations both mouse buttons (left and right) have specific functions: 

Control element Left mouse button Right mouse button 

 main menu and tool buttons menu item selection   

 kinetics button opens and closes the display instrument, Drag 
& Drop from  to  for the Kinetics display 

  

 kinetics display instrument partition line shift between analogue and digital 
display, Drag & Drop of values to  and  

  

 display name change to another display   

 table entry of calibration values, Drag & Drop values 
within the table or kinetics channels to  

Delete measurement series, 
table displays, e. g. Table font 
size 

 diagram mark evaluation ranges Settings and Evaluations in dia-
gram 

 scale shifts the x-scale (only time) or y-scale   

 axis symbols switch-over for y-scale, Drag & Drop to    

 partition line shifts the table/diagram partition line   
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File menu 

  File → New  

Deletes the recorded spectra. 

  File → Open ... 

Loads spectra with their Settings and their Evaluations. 

  File → Append ... 

Loads additional spectra to the presently open spectra. These additional spectra will be appended as additional table 
columns at the right of the table. 

  File → Save ... 

Saves the current spectra with their Settings and their Evaluations. 

  File → Page Setup ... 

Establishes the paper format and margins for a printout. 

  File → Print Preview ... 

Shows a preview of the current printout. 

  File → Print 

Prints the current diagram. 

Spectrum menu 

  Spectrum → Save Spectrum in new Column 

Saves the current spectrum in a column of its own. This makes it possible to display multiple spectra simultaneously. 
A long mouse click on the  button will save multiple spectra, one after the other, in a single operation. 

  Spectrum → Start Recording 

Starts the recording of spectra. 

  Spectrum → Pause or Resume Recording 

Pauses the recording of spectra and allows it to resume again. 

  Spectrum → Stop Recording  

Terminates the recording of spectra and deletes the last displayed spectrum. When the last displayed spectrum is to 
remain displayed, then recording must be stopped with  instead. 
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Settings menu 

  Settings → Average multiple Spectra 

Initiates averaging for the current spectrum. This permits spectra noise to be reduced in order to effectively increase 
integration time. 

  Settings → Integration Time 

Sets the spectrometer's integration time. Higher values for integration time lead to greater intensities, smaller integra-
tion times to smaller intensities. 

  Settings → Switch Lamp On 

If a lamp unit is connected, it can be switched on and off with this setting. The UV lamp unit (from 467 262) must be 
connected to an external power supply for this. 

  Settings → Additional Settings  

Remaining settings can be made in this dialog window. 

The displayed Meas. quantity of x-axis can be switched between wavelength λ in nm, energy hν in eV, wavelength 
1/λ in 1/cm and frequency f in THz. This causes x-axis numeric values to be converted accordingly but y-axis values 
retain their numeric values, except for spectrometer sensitivity and its dependent relative intensity which change with 
x-axis interval widths. 

The Reference, Transmission, Extinction and Calibration diagrams are present in Transmission / Extinction dis-
plays. Calibration can be specified with an entry for unit of concentration and the number of decimal places to the 
right of the radix point. 

The Reference, Transmission and Loss diagrams are present in Transmission / Loss displays. 

In contrast, the Relative Intensity display provides a choice of diagrams for Spectrometer sensitivity and Relative 
intensity. In order to measure spectrometer sensitivity, an entry must be made for the colour temperature of the refer-
ence radiator used. 

Spectra are generally displayed in the native resolution of the spectrometer. Use of the Smoothing to 1 nm resolu-
tion will cause spectra to be smoothed against a constant wavelength difference of 1 nm. This causes spectra to be 
smoothed since this specified resolution is less than native resolution. 

When multiple spectra are recorded, they automatically receive new colours and coloured backgrounds. This correla-
tion can be changed for every display and then again reset to default values. 

Tip 

Switching off coloured backgrounds can noticeably increase display speed on computers with slow graphic cards. 
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Table menu 

The Table menu will also open by clicking the right mouse button on the table. Individual measurement values can be 
changed or dragged (Drag & Drop) to other measurement value cells after clicking on them with the left mouse but-
ton.  

  Table → Delete Column 

If the Table menu is opened with a right-click at the head of a table column then it can be used to delete the table 
column. The last spectrum of a series of spectra can not be deleted, it can only be overwritten. 

  Table → Select Font Size 

The table's font size is selectable. Small, medium and large fonts can be selected. 

  Table → Copy Table 

Copies the table as text into the Windows clipboard. There it is then available for further processing by other Win-
dows programs. 

  Table → Copy Window  

Copies the main window as a bitmap into the Windows clipboard. There it is then available for further processing by 
other Windows programs.  
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Diagram menu 

The Diagram menu will also open by clicking the right mouse button on the diagram.  

Marking a curve range 

Some evaluations require that a curve range be marked, for which the evaluation is to be calculated. 

This is done by holding the left mouse button depressed while moving the mouse pointer from the beginning to the 
end of the curve range. Alternatively, the starting point and ending point can be clicked. 

While the curve range is being marked, the marked range will appear in turquoise. The results of most evaluations 
will be displayed even during the marking process. 

If the curve range is to be changed at a later time then a double-click on the evaluation will allow the range to be 
changed. If the range chosen lies outside the diagram, the selected evaluation will be deleted. 

Status line 

Evaluation results will be written into the status line at the bottom edge of the screen. Evaluation results can be 
dragged from the status line into the table or diagram with the mouse (Drag & Drop). This allows diagrams to be cre-
ated which are dependent on evaluation results. 

  Diagram → Display Coordinates (Alt+C) 

Once this function has been activated, the Status line will contain the current mouse pointer coordinates if the mouse 
pointer is present on the diagram. The coordinate display feature is active until it is switched off by selecting this 
menu item again or an evaluation writes its results into the status line. 

The current coordinates can also be written into the diagram. This is done by calling up menu item Text with the key-
board shortcut Alt+T, without changing the position of the mouse pointer (as this would cause false coordinates to be 
written). 

  Diagram → Select Font Size 

The font size of diagram axes is selectable. Small, medium and large fonts can be selected. 

  Diagram → Select Line Width  

The line width for display of the diagram and the evaluations it contains is selectable. Thin, medium and thick lines 
can be selected. 

  Diagram → Show Grid  

The grid of a diagram can be overlaid or hidden. 

  Diagram → Zoom (Alt+Z)  

After activating this menu item, the range to be magnified must be defined. This is done with the left mouse button. 

A zoomed display can be zoomed further. The zoom perspective can be subsequently turned off with Zoom off. 

  Diagram → Zoom Off (Alt+O)  

Returns the currently selected diagram section back to its original size. 

  Diagram → Set Marker  

Four different marking functions are available. Markers can be edited, moved or deleted from the diagram by a dou-
ble-click on the given marker. 

The marker's colour corresponds to the colour of the currently selected measurement curve. 

  Diagram → Set Marker → Text (Alt+T)  

The Text function makes it possible to write freely-selected text anywhere on the diagram. Once the text has been 
entered, it need only be moved to the desired location and set in place with the left mouse button. 

  Diagram → Set Marker → Vertical Line (Alt+V)  

This function draws a vertical line which can be positioned anywhere in the diagram. The line's position will be shown 
in the Status line. If a coordinate display was in the status line, it will be removed. 
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  Diagram → Set Marker → Horizontal Line (Alt+H)  

This function draws a horizontal line which can be positioned anywhere in the diagram. The line's position will be 
shown in the Status line. If a coordinate display was in the status line, it will be removed. 

  Diagram → Set Marker → Measure Difference (Alt+D)  

Any number of lines can be drawn into a diagram after clicking on a reference point. The coordinate difference be-
tween the given line's start and end points will be written in the Status line. If a coordinate display was in the status 
line, it will be removed. 

  Diagram → Define Range for Kinetics 

After selecting the range definition, use the left mouse button to select curve range for which the mean value is to be 
calculated. The mean value will be written into the Status line along with its statistical error. If a coordinate display 
was in the status line, it will be removed. 

In addition, a display instrument will appear which contains the value of the currently measured mean for the marked 
range. The course of values can be recorded (Kinetics). 

  Diagram → Draw Mean  

After selecting mean value calculation, the left mouse button must still be used to select curve range for which the 
mean value is to be calculated. The mean value will be written into the Status line along with its statistical error. If a 
coordinate display was in the status line, it will be removed. 

  Diagram → Calculate Peak Centre 

The centre of the marked peak will be calculated and written into the Status line. 

In addition, a display instrument will appear which contains the value of the currently measured peak centre. The 
course of values can be recorded (Kinetics). 

  Diagram → Fit Function  

Various different fit functions are available. After selecting the desired fit function, the left mouse button must still be 
used to select the curve range for which the fit function is to be calculated. 

  Diagram → Fit Function → Best-fit Straight Line y=Ax+B 

  Diagram → Fit Function → Straight Line through Origin y=Ax 

  Diagram → Fit Function → Tangent y=Ax+B 

  Diagram → Fit Function → Normal Parabola y=Ax
2
 

  Diagram → Fit Function → Parabola y=Ax
2
+Bx+C 

  Diagram → Fit Function → Hyperbola 1/x y=A/x+B 

  Diagram → Fit Function → Hyperbola 1/x
2
 y=A/x

2
+B 

  Diagram → Fit Function → Exponential Function y=A*exp(-x/B) 

  Diagram → Fit Function → Gaussians of equal Width 

Gauss curves or sums of Gauss curves can be fit to the spectrum with this menu item.  

The results of the Gauss fit function is a formula comprised of multiple summands of type  

 

where the fit of parameters A, μ and σ will be determined. 

In the simplest case, exactly one Gauss curve will be fit in the marked range. If the fit is to be formed by the sums of 
multiple Gauss curves then the quantity and rough position of individual maxima (peaks) must be specified. This is 
done with markers drawn in advance (peak centres or vertical lines). 

  Diagram → Fit Function → Free Fit (Alt+F) 

To perform a free fit, the f(x,A,B,C,D) function must be selected and realistic initial values specified before range 
marking. Initial values should be chosen which are as realistic as possible so that the fit has a good chance of suc-
cess. If the fit fails, it can be repeated with altered initial values. Furthermore, individual parameters A, B, C or D can 
be kept constant during the fit. 

The current parameters (A, B, C and D) for the fit will be written into the Status line. If a coordinate display was in the 
status line, it will be removed. 
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  Diagram → Calculate Integral   

The integral's value is determined from the area, either the curve range selected with the left mouse button to be 
incorporated into the x-axis, or from the peak area. The integral's value will be written into the Status line. If a coordi-
nate display was in the status line, it will be removed. 

In addition, a display instrument will appear which contains the value of the currently measured integral. The course 
of values can be recorded (Kinetics). 

  Diagram → Delete Last Evaluation  

Deletes the given last evaluation of a display. 

  Diagram → Delete All Evaluations  

Deletes all evaluations of a display. 

  Diagram → Delete Range (only measured values)  

The measured values of the marked curve range will be deleted. This effects only measured values presented on the 
y-axis. Evaluated quantities or values on the x-axis cannot be deleted. 

  Diagram → Copy Diagram 

Copies the diagram as a metafile or bitmap into the Windows clipboard. There it is then available for further process-
ing by other Windows programs. 

  Diagram → Copy Window  

Copies the main window as a bitmap into the Windows clipboard. There it is then available for further processing by 
other Windows programs.  
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Kinetics 

Some evaluations not only present results in the status line but also keep track of ongoing conditions in a dedicated 
display instrument. These evaluations are: 

  Diagram → Define Range for Kinetics 
  Diagram → Calculate Peak Centre 
  Diagram → Calculate Integral → Area to x-axis 
  Diagram → Calculate Integral → Peak Area 

Display instruments are hidden by default but they can be called up by clicking on the appropriate tool button at the 
right end of the top line. 

The display instrument in the Kinetics display (rightmost tab) keeps track of current values. To put this feature into 

operation one only needs to drag (Drag & Drop) the desired display instrument's tool button onto the diagram with the 
mouse and start the recording. 

  Kinetics → Start kinetics 

Starts a recording for the timed course of selected evaluation results. 

  Kinetics → Stop kinetics 

Stops the recording for a timed course. 

Help menu 

  Help → Help 

Calls up help. 

  Help → About ... 

Provides information about the software's version and permits entry of the activation code. 
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Offset I0 

Offset I0 will be measured in this display - which will be subtracted in advance from all other spectra. 

If no offset spectrum exists when this display is selected, it will be measured automatically. To overwrite an existing 
offset spectrum,  must be deactivated. 

No light at all or only the light of a constant background should be allowed into the spectrometer in order to measure 
a correct offset spectrum. 

Changes made to the Settings menu may require the offset spectrum to be measured again (e.g. after  or  with 
background illumination). 

Intensity I1 = I - I0 

A previously measured Offset I0 will be subtracted from the current spectrum and presented in this display as Inten-

sity spectrum I1. 

The recording of this spectrum can be influenced via the Spectrum menu (e.g.  or ) or the Settings menu (e.g.  
or ). 

Reference I2 = I - I0 

Reference spectrum I2 will be measured in this display. It then serves as the 100 % reference for the transmission 

spectrum and the extinction spectrum. 

If no reference spectrum yet exists when this display is selected, it will be measured automatically. To overwrite an 
existing reference spectrum,  must be deactivated. 

A cuvette with reference solution (extinction and concentration measurement) should be inserted into the cuvette 
holder or without filter in the beam path (filter transmission measurement) in order to measure a correct reference 
spectrum. 

When using the cuvette holder, be sure the integrated light source is switched on with . 

Changes made to the Settings menu may require the reference spectrum to be measured again (e.g. after  or ). 

Transmission T = I1/I2 

This display will present the current spectrum as a transmission spectrum T which has been divided by a previously 
measured Reference spectrum I2. 

The recording of a transmission spectrum can be influenced via the Spectrum menu (e.g.  and ). 

Extinction E = -log(I1/I2) 

This display will present the current spectrum as an extinction spectrum (logarithmic absorption spectrum) which has 
been divided by a previously measured Reference spectrum I2 and multiplied by the logarithmic factor. 

The recording of an extinction spectrum can be influenced via the Spectrum menu (e.g.  and ). 

Loss a = -10*log(I1/I2) 

This display will present the current spectrum as a loss spectrum in dB which has been divided by a previously 
measured Reference spectrum I2 and multiplied by the logarithmic factor. 

The recording of a loss spectrum can be influenced via the Spectrum menu (e.g.  and ). 
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Calibration 

The calibration of a concentration measurement will be performed in this display. 

Prerequisite for the calibration is an evaluation channel with display instrument, as is also needed for Kinetics. Typi-
cally this is done with 

  Diagram → Define Range for Kinetics 

in an extinction spectrum. A tool button will then appear at the right edge of the top line with which the extinction can 
be displayed for the selected range. 

If the Offset and Reference spectra have been correctly recorded, this extinction will show 0 for a concentration of 0 
mg/l. 

This is why c = 0 mg/l and E = 0 are to be entered into the first line of the calibration table. Any number of additional 
lines in the table can be used to enter incremental increases of concentration for calibration solution and respective 
values for concentration c and extinction E. 

Alternatively, values for extinction E can be entered into the table by simply dragging the display instrument's digital 
display into the table with the mouse (Drag & Drop). 

After the entry of calibration points, a new display instrument c will appear automatically with which Kinetics can also 
be recorded against time. 

By default, intermediate values will be calculated by linear interpolation of the two adjacent values from the calibration 
table. However, if one of the evaluations 

  Diagram → Fit Function → Straight Line through Origin 
  Diagram → Fit Function → Best-fit Straight Line 
  Diagram → Fit Function → Normal Parabola 
  Diagram → Fit Function → Parabola 
  Diagram → Fit Function → Exponential Function e^x 
  Diagram → Fit Function → Free Fit 

is selected then the given evaluation results will be used for interpolation. 

Tip 

The calibration table can also be built in descending order. This is the easier approach when making up calibration 
solutions. In this case, point c = 0 mg/l and E = 0 will then be the last table line. 
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Spectrometer sensitivity I2 

Spectrometer sensitivity is measured in the Spectrometer sensitivity I2 display. The result of this measurement serves 

as a reference for Relative intensity I3 spectra. 

If a spectrometer sensitivity measurement was not done before this display was selected, it will now be measured 
automatically. To overwrite an existing spectrometer sensitivity,  must be deactivated. 

To measure spectrometer sensitivity correctly, a radiation source having good Planckian radiation distribution (black 
body) with known colour temperature should be used. Colour temperature must be specified in  Settings → Addi-
tional Settings. 

 Changes made to the Settings menu (e.g. after  or ) may require that spectrometer sensitivity be measured 
again. 

Note 

This display exists only after a change to the Relative Intensity display has been made in  Settings → Additional 
Settings. 

Relative Intensity I3 = I1/I2 

This display will present the current spectrum as a Relative intensity I3 spectrum which has been divided by a previ-

ously measured Spectrometer sensitivity I2. 

The recording of a relative intensity spectrum can be influenced via the Spectrum menu (e.g.  and ). 

X-axis dependency 

Both spectrometer sensitivity as well as relative intensity depend on whether they are to be displayed against wave-
length λ or energy hν. This is because respective intervals between two adjacent points have non-linear dependen-
cies. For example, as a consequence of this the maximum of a Planckian radiation curve will be located at different 
colours. 

Determining colour temperature 

Use of  Diagram → Fit Function → Free Fit makes it possible to determine the colour temperature of a measured 

Planckian radiation curve. Radiation laws for presentation against wavelength (formula with x
5
) and against energy 

(formula with x
3
) are provided in the formula's selection box f(x,A,B,C,D). However, appropriate initial values for 

A (maximum amplitude, e.g. 100) and B (approximate colour temperature in Kelvin) must be specified. 

Note 

This display exists only after a change to the Relative Intensity display has been made in  Settings → Additional 
Settings. 
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Experiment examples 

Example experiments can help you learn how to use SpectraLab. Where applicable, the experiment number from the 
main catalogue of physics experiments is given. Data measured in the examples can be loaded directly into Spectra-
Lab. Simply click on the  symbols in the descriptions. New examples are marked with a red •. 

Physics  

• P5.2.4.3 Transmission spectra of coloured glasses 
• P5.2.4.4 Transmission and fluorescence spectra of coloured liquids 
• P5.2.5.1 Reflection spectra of different materials 
• P6.2.2.5 Recording Frauenhofer lines 
• P6.2.2.4 Recording the emission spectra of flame colouration 
• P6.2.2.6 The emission lines of gas discharge lamps 
•   Spectra of an incandescent lamp and an energy saving lamp 
• P5.2.4.5 Absorption spectrum of an optical waveguide 
• P5.5.2.4 Investigation of Wien's displacement law 

Chemistry 

•   Extinction spectrum of a crystal violet solution 
•   Colour removal from crystal violet with sodium hydroxide 
•   Extinction spectra of food colourings  
•   Absorption/reflection of UV light by sun protection agents 
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Transmission spectra of coloured glasses 

 

Experiment description 

This experiment will record the light of an incandescent lamp passed through coloured glasses with a spectrometer 
and compare this light to the continuous spectrum of the lamp's light. The transmission coefficient and optical density 
(extinction) of the coloured glasses will be calculated. 

Required equipment  

1 Compact spectrometer, physics 467 251 
1 Fibre holder 460 251 
1 Lamp housing with cable 450 60 
1 Bulb, 6 V/30 W, E14, set of 2 450 511 
1 Condenser with diaphragm holder 460 20 
1 Transformer, 6/12 V 521 210 
1 Holder with spring clamps 460 22 
  Various filters, e.g.:   
1 Light filter, dark red 468 01 
1 Light filter, blue-green 468 09 
1 Light filter, blue with violet 468 11 
      
1 Optical bench, S1 profile, 1 m 460 310 
3 Clamp rider with clamp 460 311 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Place the lamp in the housing but do not yet make a connection to the 6 V transformer output. Initially leave the 
filter holder empty, i.e. without any filter in the spring clamps. 

Performing the experiment 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Connect the lamp to the 6 V transformer output. 

 Align the fibre optic waveguide to maximise intensity. Adapt the integration time, either directly or with  or 
, such that maximum intensity lies between 75 % and 100 %. Do not change the integration time again af-

ter this. 

 Switch off the light again to record the background spectrum. 
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 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Connect the lamp again to the 6 V transformer output. 

 The displayed spectrum serves as a reference spectrum for the following measurement. Suspend reference 
measurement with . 

 Place a filter in the spring clamps of the filter holder. 

 The light spectrum passing through the filter can now be seen in the Intensity I1 display. The reference 
spectrum is also displayed in grey. 

 The filtered spectrum's relationship to the reference curve is calculated and presented in the Transmission 

T display. 

 Extinction (optical density) will be calculated and presented in the Extinction E display. 

 The  control can be used to save the transmission spectrum for all displays simultaneously. 

 Repeat the experiment with other filters. 

Evaluation 

After inserting a filter into the holder's spring clamps, the broad spectrum with various spectral colours disap-
pears. When light filters are inserted, only the band of the filter's colour components remains in the visible spec-
tral range. The other components of the visible spectrum are absorbed. The transmission of long wavelengths 
increase with all filters, especially those in the infrared spectral range. Therefore the filter's colour does not 
permit conclusions to be drawn about transmission characteristics outside the visible spectral range. 

Notes 

In the Transmission and Extinction displays, only those ranges are evaluated whose intensities in the refer-
ence curve amount to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 



  

  
  

  

SpectraLab 
  

 
© by LD DIDACTIC GmbH · Leyboldstrasse 1 · D-50354 Huerth · www.ld-didactic.com 

Tel: +49-2233-604-0 · Fax: +49-2233-604-222 · E-mail: info@ld-didactic.de · Technical alterations reserved 
  

  

23 

Transmission and fluorescence spectra of coloured liquids 

 

Experiment description 

This experiment explores how fluorescence responds by recording the transmission spectrum for absorption and the 
emission spectrum for scattering. The emitted light from a liquid coloured with fluoresceine is viewed at right angles. 
A blue filter is used to distinguish the fluorescence from the scattered light. 

Required equipment  

1 Compact spectrometer, physics 467 251 
1 Fibre holder 460 251 
1 Lamp housing with cable 450 60 
1 Bulb, 6 V/30 W, E14, set of 2 450 511 
1 Condenser with diaphragm holder 460 20 
1 Transformer, 6/12 V 521 210 
1 Holder with spring clamps 460 22 
1 Light filter, blue with violet 468 11 
1 Plate glass cell (cuvette) 477 14 
1 Prism table 460 25 
1 Fluoresceine, 25 g 672 0110 
1 Microspatula 604 5672 
1 Optical bench, S1 profile, 1 m 460 310 
4 Clamp rider with clamp 460 311 
1 Saddle base 300 11 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Place the lamp in the housing but do not yet make a connection to the 6 V transformer output. Fill the plate 
glass cell with water and dye the water with a very small trace of fluoresceine. Dip the tip of a spatula into fluo-
resceine powder and tap off whatever clings into the water. 

Initially you should not set up either the filter (clipped into a holder with spring clips) or the plate glass cell on 
the prism table. 

Performing the experiment 

Recording the transmission spectrum 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 



  

SpectraLab 
  

  

  
  

 
© by LD DIDACTIC GmbH · Leyboldstrasse 1 · D-50354 Huerth · www.ld-didactic.com 

Tel: +49-2233-604-0 · Fax: +49-2233-604-222 · E-mail: info@ld-didactic.de · Technical alterations reserved 
  

  

24 

 Connect the lamp to the 6-V output of the transformer and move it in its housing till the optical fibres are well 
illuminated. 

 Align the fibre optic waveguide to maximise intensity. Adapt the integration time, either directly or with  or 
, such that maximum intensity lies between 75 % and 100 %. Do not change the integration time again af-

ter this. 

 Switch off the light again to record the background spectrum. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Connect the lamp again to the 6 V transformer output. 

 The displayed spectrum serves as a reference spectrum for the following measurement. Suspend reference 
measurement with . 

 Put the plate glass cell on the prism table. 

 The light spectrum passing through the liquid can now be seen in the Intensity I1 display. The reference 
spectrum is also displayed in grey. 

 The liquid's spectrum's relationship to the reference curve is calculated and presented in the Transmission 

T display. 

 Extinction (optical density) will be calculated and presented in the Extinction E display. 

 The  control can be used to save the transmission spectrum for all displays simultaneously. 

Recording the emission spectrum 

 Set up the fibre holder in such a way that the fibre is perpendicular to the side and pointing towards the 
plate glass cell. It may be necessary to move the lamp housing in order to shift the focal point into the plane 
of the cell in such a way that the fluoresceine fluoresces clearly. Point the optical fibre at the brightest area 
possible. 

 View the spectrum on the Intensity I1 display. Use  to increase the integration time till the spectrum is 
clearly visible. 

Recording the transmission spectrum with light filter 

 Move the fibre holder back into the direct path of the beam. 

 Introduce a blue/violet filter into the beam. 

 Alter the display to Reference I2 and use  to start a reference measurement. Adapt the integration time, 
either directly or with  or , such that maximum intensity lies between 75 % and 100 %. Do not change 
the integration time again after this. 

 The displayed spectrum serves as a reference spectrum for the following measurement. Suspend reference 
measurement with . 

 Put the plate glass cell on the prism table. 

 The light spectrum passing through the liquid can now be seen in the Intensity I1 display. The reference 
spectrum is also displayed in grey. 

Evaluation 

A minimum appears in the transmission spectrum from the cell filled with fluoresceine at about 490 nm. You may 
need to reduce the absorption by diluting the fluoresceine or shortening the path taken by the light by rotating the 
plate glass cell. 

In the emission spectrum for the light emitted from the side, there is a clear peak in the green region with a maximum 
at 520 nm. 

In the spectrum for the lamp with the blue/violet filter in the path in I2 display, there is a clear peak with a maximum 
at about 460 nm. In the spectrum of the light, as shown in the I2 display, for the light beyond the cell filled with fluo-
resceine there is considerable absorption of the blue/violet peak, while the intensity in the green region is increased. 
This can be made more obvious by dragging with the mouse along the y-axis, for example. 

Fluoresceine is excited by blue light (value of absorption maximum quoted in literature: 485 nm at pH 9) and then it 
emits green light (520 to 530 nm). 

Notes 

It would be more precise in terms of the physics if the reference spectrum were to be recorded first with the 
plate glass cell filled only with water (no fluoresceine). 

Fluorescence emitted due to ambient light can be minimised by darkening the room. 
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Absorption spectra and transmission spectra are in fact equivalent: T = 1 - A. Where the transmission spectrum 
exhibits a minimum, the absorption spectrum exhibits a maximum. 

In the Transmission and Extinction displays, only those ranges are evaluated whose intensities in the refer-
ence curve amount to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Reflection spectra of different materials 

 

Experiment description 

Our impression of the colour of opaque objects arises from the part of the colour spectrum those objects reflect. 

In this experiment, the light from an incandescent lamp is analysed using a spectrometer after reflection by various 
materials. By comparison with the reflection from a sheet of white paper (scattered light), the reflection coefficient can 
be calculated. 

Required equipment  

1 Compact spectrometer, physics 467 251 
1 Fibre holder 460 251 
1 Lamp housing with cable 450 60 
1 Bulb, 6 V/30 W, E14, set of 2 450 511 
1 Condenser with diaphragm holder 460 20 
1 Transformer, 6/12 V 521 210 
1 Holder with spring clamps 460 22 
1 Conductors/insulators, set of 6 567 06 
1 Optical bench, S1 profile, 1 m 460 310 
3 Clamp rider with clamp 460 311 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Plug the lamp into the lamp housing. Cut of a strip of white paper (matching the dimensions used in the con-
ductors/insulators set: 1.5 cm x 8 cm) and clip it into a holder with spring clips. Connect the lamp to the 6-V 
output of the transformer and set it up in such a way that a bright area appears on the paper strip next to the 
fibre holder (an unfocussed image of the hot filament). Turn the fibre holder till the fibre points at this area. 

Performing the experiment 

Recording the reference spectrum 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Adapt the integration time, either directly or with  or , such that maximum intensity lies between 75 % 
and 100 %. Do not change the integration time again after this. 

 In order to record the background spectrum, remove the paper strip and turn off the lamp. 

 Open the Offset I0 display. 
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 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Clip the paper a strip back into the holder with spring clips and turn on the lamp. 

 The displayed spectrum serves as a reference spectrum for the following measurement. Suspend reference 
measurement with . 

Recording reflection spectra (reflection from various materials) 

 Remove the paper strip from the holder and replace it in turn with each of the samples from the conduc-
tors/insulators set. 

 The spectrum after reflection of light by the strips can be viewed in the Intensity I1 display. The reference 
spectrum is also displayed in grey. 

 For the Transmission T display, the relationship between the reflected spectrum and the reference spec-
trum is calculated and displayed. 

 The  control can be used to save the reference spectrum for all displays simultaneously. 

Evaluation 

In the reflection spectra for aluminium (red) and polystyrene (violet) there is a roughly uniform dimming effect across 
the whole region, i.e. particularly in the visible region from about 400 to 800 nm (in this example the dimming is by 60 
to 80 % and by 70 to 85 %). For this reason, both these materials look grey. 

In the reflection spectra of wood (blue) and brass (black) there is clear dimming in the short-wavelength region, i.e. 
the blue part of the spectrum. For this reason, the materials have a yellowish colour (the complementary colour for 
blue). It is also clear that there is more red in the spectrum for wood. 

Since the dark Pertinax (green) reflects mainly red and infrared components with a wavelength greater than about 
750 nm, it looks almost black. 

Transparent acrylic (dark blue) scatters no light, i.e. no light is reflected towards the fibre. 

Notes 

In this experiment, the scattered light of the directed light beam from the lamp is primarily observed from a fixed angle 
(diffuse reflection). For the reflective surfaces (brass, Pertinax, acrylic) a large part of the reflection is specular, i.e. 
not reflected in the direction of the fibre. 

It is also recommended that other materials be used for reflection experiments. In particular, it is possible to view 
plant leaves, which absorb light in the red and blue regions (chlorophyll bands) and reflect light in the green region. 

Using colour filters, i.e. not white light, the materials will look different in colour depending on their reflective proper-
ties and these colours should also be identifiable in the reflection spectrum. The room should be darkened so that 
there is no error in the results due to ambient light. 

In the Transmission and Extinction displays, only those ranges are evaluated whose intensities in the refer-
ence curve amount to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Recording Frauenhofer lines 

 

Experiment description 

Fraunhofer lines are dark lines in the sun's spectrum. They were first systematically studied by Joseph von Fraun-
hofer. Such lines are created because gasses in the photosphere, i.e. the sun's visible surface, absorb a portion of 
the sun's light. Thus the Fraunhofer lines make it possible to draw conclusions about the chemical composition and 
temperature of the photosphere. In this experiment, a spectrum of the sun or sky will be recorded and the wave-
lengths of absorption lines will be determined. 

Required equipment  

1 Compact spectrometer, physics 467 251 
  or   
1 Compact UV spectrometer, physics 467 261 
1 Fibre holder 460 251 
1 Saddle base 300 11 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Direct the fibre holder with fibre optic waveguide toward the sky. 

Performing the experiment 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Align the fibre optic waveguide to maximise intensity. Adapt the integration time, either directly or with  or 
, such that maximum intensity lies between 75 % and 100 %. 

 Put a light-tight cover over the fibre optic waveguide's entrance slit to measure the background spectrum. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change back to the Intensity I1 display. 

 Remove the cover over the fibre optic waveguide's entrance slit. 

 Use the  control to stop the measurement or save the spectrum with . 

 If desired, record further spectra, e.g. 
- in different skyward directions 

- comparing sky to clouds 

- at different times of day  
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Evaluation 

The measured spectrum shows a broad distribution with many minimums. To determine the wavelength of a mini-
mum, a vertical line can be drawn and the wavelength read. 

The minimums correspond to the absorption lines of various elements. The most prominent lines are listed in the 
table below along with their respective elements. For the most part, absorption occurs in the sun's photosphere. The 

lines A, B, a, y and Z occur due to absorption of O2 in the earth's atmosphere. 

Other absorption lines or bands (including those at 720 nm and 810 nm) can be traced to water vapour in the earth's 
atmosphere. 

Symbol Element Wavelength (nm) 
y O2 898.765 

Z O2 822.696 

A O2 759.370 

B O2 686.719 

C Hα 656.281 

a O2 627.661 

D1 Na 589.594 

D2 Na 588.997 

D3 He 587.565 

E2 Fe 527.039 

b1 Mg 518.362 

b2 Mg 517.270 

b3 Fe 516.891 

b4 Fe 516.751 

b5 Mg 516.733 

c Fe 495.761 
F Hβ 486.134 

d Fe 466.814 
e Fe 438.355 
G' Hγ 434.047 

G Fe 430.790 
G Ca 430.774 
h Hδ 410.175 

H Ca
+
 396.847 

K Ca
+
 393.368 

L Fe 382.044 
N Fe 358.121 
P Ti

+
 336.112 

T Fe 302.108 
t Ni 299.444 

Note 

Many Fraunhofer lines are already drawn into the above described examples. These examples make it easy to create 

templates for one's own measurements. To do this, simply delete the spectrum with  after loading the example. 
The drawn lines will remain in place. Subsequently a new spectrum can be recorded with . 



  

SpectraLab 
  

  

  
  

 
© by LD DIDACTIC GmbH · Leyboldstrasse 1 · D-50354 Huerth · www.ld-didactic.com 

Tel: +49-2233-604-0 · Fax: +49-2233-604-222 · E-mail: info@ld-didactic.de · Technical alterations reserved 
  

  

30 

Recording the emission spectra of flame colouration 

 

Hazard warnings  

Barium chloride is harmful if inhaled and poisonous if swallowed. 

Calcium chloride irritates the eyes. Do not inhale dust. Avoid contact with skin. 

Copper (II) nitrate and lithium chloride are harmful if swallowed. They irritate the eyes and skin. 

Hydrochloric acids cause chemical burns! Wear protective goggles! 

Protect long hair from being burned! 

Experiment description 

Some metal salts, particularly alkaline and earth alkaline metals, exhibit characteristic light emissions in the visible 
range when thermally excited (e.g. by a non-luminous flame). The naked eye sees a coloured flame in these cases. 
By using a spectrometer, one can break down the spectral distribution of the emission spectrum and even differenti-
ate between various mixtures of metal salts 

Required equipment  

1 Compact spectrometer, physics 467 251 
1 Fibre holder 460 251 
1 Saddle base 300 11 
1 Butane gas cartridge burner 666 711 
1 Butane gas cartridge, 190 g 666 712 
1 Gas igniter, mechanical 666 731 
1 Magnesia sticks, 25 each 673 0840 
1 Powder spatula, 150 mm 604 5681 
1 Salts for flame colouration 661 088 
1 Dropping pipette, e.g. from 665 953 
1 Rubber cap, e.g. from 665 954 
1 Spot plate 667 089 
1 Hydrochloric acid, e.g.  674 6850 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Place a rubber bulb on the dropping pipette. Place a small amount (only a few crystals) of each of the various 
salts on the spot plate, each salt in a separate dimple, and mark them. Be careful that these samples do not get 
unintentionally mixed! Moisten each sample with 1 drop of hydrochloric acid. 
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Note 

Even small traces of sodium salts will colour the flame yellow and cover up all other emissions. Therefore abso-
lute cleanliness is to be observed for these experiments. Crystals may never be allowed to fall into the burner! 

Performing the experiment 

 Ignite the burner then open the air intake fully. 

 Activate  to begin a new measurement. 

 Start the measurement with . 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Select the Intensity I1 display. Intensity now lies at 0 % for the entire spectral range. 

 Thoroughly anneal a magnesia stick in the burner's flame (dip it in hydrochloric acid beforehand). 

 Use the still-hot end of the magnesia stick to pick up a few salt crystals from the spot plate. 

 Hold the magnesia stick in the burner's flame and observe the flame's colouration with the naked eye. 

 Adjust integration time directly or with  or  such that the intensity of the lines is maximised. If necessary, 
align the fibre optic waveguide to maximise intensity. 

 Save the spectrum with . 

 Repeat the experiment with other salts. In subsequent repetitions of the experiment, either break off the 
magnesia stick's contaminated tip or use a new, clean magnesia stick. 

Evaluation 

The flame produces a characteristic colouration for every salt. This is a consequence of the colour and intensity of 
the given emission lines. The table below summarizes flame colouration and wavelength for the most important 
emission lines of individual elements. 

Element Flame colouration, visual Wavelength of most important lines in nm 

Barium green 524.2 (green); 513.7 (green) 
Calcium tile red 622.0 (red); 553.3 (green) 
Caesium blue 458.0 (blue); 852.1 (IR); 894.3 (IR) 
Copper green (in the presence of Cl

-
) 

blue (pure copper nitrate) 

510.5; 515.3; 521.8 (all green) 

Potassium violet 786.3 (red); 404.4 (violet) 
Lithium red 670.8 (red) 
Sodium yellow 589.3 (yellow) 
Rubidium red-violet 780.0 (red); 794.8 (red); 420.0 (violet) 
Strontium scarlet red 604.5 (orange); 460.7 (blue); multiple red lines 

As the spectra of individual example experiments show, some elements also emit strong lines in the ultraviolet and 
infrared ranges which cannot be observed with the naked eye (e.g. Cs), or only with difficulty such as with potassium 
(by filtering out the bright sodium line with cobalt glass). 

Contamination with sodium is often difficult to avoid. Whereas the bright yellow sodium line easily covers up weaker 
lines to the naked eye, they are readily visible (even in mixtures) with the spectrometer. 

Further investigations can be made with other samples, such as vegetation ash, wood ash, cooking salt or similar. 

High potassium content can be seen in the wood ash example. Furthermore, lines of sodium and rubidium are visible. 

Note 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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The emission lines of gas discharge lamps 

 

Experiment description 

Gas discharge lamps produce spectra which consist only of individual spectral lines. These are referred to as line 
spectra. The wavelengths of individual spectral lines are characteristic for the given gas. This experiment will investi-
gate the emission spectrum of a quicksilver spectral tube. 

Required equipment  

1 Compact spectrometer, physics 467 251 
  or   
1 Compact UV spectrometer, physics 467 261 
1 Fibre holder 460 251 
1 Spectral tubes, e.g. Hg (with Ar) 467 63 
1 Holder for spectral tubes 467 81 
1 High-voltage power supply, 10 kV 521 70 
1 Measuring resistor, 100 kΩ 536 251 
1 Stand base, small 300 02 
1 Saddle base 300 11 
1 Safety connection lead, 50 cm, red 500 621 
1 Safety connection lead, 50 cm, blue 500 622 
1 Safety connection lead, 25 cm, red 500 611 
1 Safety connection lead, 25 cm, yellow-green 500 610 
1 PC with Windows 2000/XP/Vista/7/8   

The line spectra of various gasses and the wavelengths of spectral lines are listed in the spectral table (667 7101). 

Experiment setup (see picture) 

Insert the spectral tube into the spectral tube holder. Put the fibre optic waveguide into the fibre holder and 
place it in front of the spectral tube. 

Performing the experiment 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Switch on the high-voltage power supply and slowly increase voltage until it ignites the spectral tube 
(2−5 kV). 

 Align the fibre optic waveguide to maximise intensity. Adapt the integration time, either directly or with  or , 
such that maximum intensity lies between 75 % and 100 %. 
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 Turn down the high-voltage back to zero in order to measure the background spectrum. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change back to the Intensity I1 display. 

 Slowly increase voltage again until the spectral tube ignites (2−5 kV). 

 Use the  control to stop the measurement or save the spectrum with . 

 If desired, record spectra for other spectral tubes. 

Evaluation 

The spectrum of Hg (with Ar) spectral tubes are comprised of various spectral lines. To determine the wave-
length, a vertical line can be drawn and the wavelength read. The strongest emission lines from quicksilver lie 
at 366 nm, 405 nm, 436 nm, 546 nm, 577 nm and 579 nm. The emission lines in the red and infrared spectral 
range originate from the Argon used in the spectral tube as the igniting gas. 

Note 

Spectral tubes with the following gas fillings are also available: 

N2, O2, H2, H2O, He, Ar, Ne, Kr. 
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Spectra of an incandescent lamp and an energy saving lamp 

 

Experiment description 

In an incandescent lamp, an electric conductor is heated by an electric current causing it to glow. The emitted spec-
trum is continuous and can be described with Planck's radiation formula. The radiation maximum of the radiation 
shifts with increasing temperature T according to Wien's displacement law 

λmax = 2.9 * 10
-3

 K / T 

toward smaller wavelengths; at the same time the maximum value of the radiation increases. At the temperatures 
attained by normal incandescent lamps, about 2300 to 2900 K, the radiation maximum lies in the infrared spectral 
range. 

Energy saving lamps (compact fluorescent lamps) are not thermal radiators but rather quicksilver gas discharge 
lamps. Thus they emit a line spectrum. Furthermore, they are internally coated with a fluorescent luminophore that 
converts the ultraviolet radiation components into visible radiation. The spectrum therefore contains additional lines or 
bands. The position and width of these depends on the luminophore used and determines the colour impression and 
colour reproduction of the lamps. 

The spectra of an incandescent lamp and an energy saving lamp will be recorded in this experiment. By specifying 
the incandescent lamp's colour temperature the wavelength dependency of spectrometer sensitivity can be deter-
mined so that the course of spectra intensity can be corrected in the representation. The spectral distribution differ-
ences between incandescent lamp and energy saving lamp are, above all, clearly evident in the infrared range. How-
ever, a comparison of overall radiation intensity in the visible spectral range reveals little difference. 

Required equipment  

1 Compact spectrometer, physics 467 251 
1 Fibre holder 460 251 
1 Lamp socket, E 27 451 17 
1 Incandescent lamp, E 27, 60 W 505 301 
1 Energy saving lamp, E 27, 11 W 505 3181 
2 Saddle base 300 11 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Put the incandescent lamp into the lamp socket. Set up the fibre optic waveguide in the fibre holder at a dis-
tance of about 1 m from the incandescent lamp. 
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Performing the experiment 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Switch on the incandescent lamp. 

 Adapt the integration time, either directly or with  or , such that maximum intensity lies at about 20 %. 
Adjust the fibre optic waveguide if necessary. 

 Switch off the light again to record the background spectrum. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 In  Settings → Additional Settings select the Relative Intensity display and enter the color temperature 
2680 K (incandescent lamp, 60 W). 

 Change to the (now available) Spectrometer sensitivity I2 display. 

 Switch on the incandescent lamp again. 

 The displayed spectrum serves as a reference for relative I3 intensity spectra. 

 Change to the Relative Intensity I3 display. 

 Save the spectrum with . 

 Replace the incandescent lamp with the energy saving lamp; pay attention that the energy saving lamp is at 
the same position where the incandescent lamp was. 

 Measure and save the energy saving lamp's spectrum. Further reduce exposure time if necessary. 

Evaluation 

In the Intensity I1 display the incandescent lamp exhibits a continuous spectrum with a maximum at about 620 nm. 

Thus the position of the maximum does not correspond to the position for T = 2680 K according to Wien's displace-

ment law: λmax = 1082 nm. This deviation is caused by spectrometer sensitivity (grey curve), which is not constant for 

all wavelengths. 

If one determines spectrometer sensitivity on the basis of filament temperature then the measured spectra can be 
corrected by this factor. Measured spectrometer sensitivity can be seen in the Spectrometer sensitivity display. It 
has its maximum at 520 nm and drops off substantially toward the range limits. 

In the corrected display, Relative Intensity I3, the incandescent lamp's spectrum shows the expected distribution. 

Intensity increases for increasing wavelengths, a maximum is not reached within the investigated wavelengths. The 
incandescent lamp therefore radiates primarily in the infrared range. 

The spectrum for the energy saving lamp differs significantly from the incandescent lamp's spectrum. There are mul-
tiple sharp lines present in the blue and UV range. In the range between 470 nm and 720 nm there are number of 
wide bands present. There are almost no emissions present in the infrared spectral range. The sharp blue lines are 
part of quicksilver's spectrum, with lines at 365 nm, 404 nm, 436 nm, 546 nm, 577 nm and 579 nm. In this example 
these wavelengths are marked with vertical lines. The additional bands between 470 nm and 720 nm are emitted by 
the fluorescent coating. Therefore emissions lie primarily in the visible spectral range. 

Overall intensity for a specific spectral range can be determined by integration: Calculate Integral → Area to x-axis. In 
this example, integration has been done for both spectra within the wavelength range 500 - 630 nm. This is where the 
human eye has its greatest sensitivity. The result for the incandescent lamp is 3479 %*nm and for the energy saving 
lamp is 2928 %*nm. The intensity of both lamps is thus comparable despite the difference in electric power con-
sumed, 60 W and 11 W respectively. 

Notes 

Typical incandescent lamp temperatures by specified nominal power:  

40 W incandescent lamp: 2200 K 
60 W incandescent lamp: 2680 K 
100 W incandescent lamp: 2800 K 
200 W incandescent lamp: 3000 K 
halogen lamp: 3000 K  

In the Relative Intensity display, only those ranges are evaluated whose spectrometer sensitivity curve intensity 
amounts to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Absorption spectrum of an optical waveguide 

 

Experiment description 

Depending on type, the inside of an optical waveguide (optical fibre) consists of quartz glass or transparent plastic. 
The plastic materials (e.g. PMMA, polymethyl methacrylate) are particularly prone to wavelength-dependent absorp-
tions. Due to the length of a fibre optic waveguide, even small absorption cross-sections play a role and result in 
clearly visible bands of higher absorption in the spectrum as well as optical windows in which the fibre passes light 
with low losses. 

Required equipment  

1 Compact spectrometer, physics 467 251 
1 Fibre holder 460 251 
1 Lamp socket, E 27 451 17 
1 Incandescent lamp, E 27, 60 W 505 301 
2 Saddle base 300 11 
1 Optical fibres, set of 2 579 44 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Put the incandescent lamp into the lamp socket. Set up the spectrometer's optical fibre in the fibre holder at a dis-
tance of about 1 m from the incandescent lamp. Lay the optic waveguide at the ready. 

Performing the experiment 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Switch on the incandescent lamp. 

 Align the fibre optic waveguide to maximise intensity. Adapt the integration time, either directly or with  or 
, such that maximum intensity lies between 75 % and 100 %. Do not change the integration time again af-

ter this. 

 Switch off the light again to record the background spectrum. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Switch on the incandescent lamp again. 

 The displayed spectrum serves as a reference spectrum for the following measurement. 

 Change to the Transmission T display. A continuous line at 100 % results. 
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 Remove the spectrometer's fibre optic waveguide from the lamp then hold a piece of the fibre optic 
waveguide (PMMA) directly in front of the spectrometer's waveguide and the other end in the direction of the 
lamp. If necessary, change the distance to match the aperture angles of the fibres. 

 Stop the measurement with , which may require a third hand. 

 For the Transmission T display, the relationship of the spectrum with fibre optic waveguide (PMMA) + fibre 
optic waveguide (quartz), one after the other, will be calculated and displayed as a reference curve for the 
spectrometer's fibre optic waveguide alone. 

 Extinction (optical density) will be calculated and presented in the Extinction E display. 

 The  control can be used to save the transmission spectrum for all displays simultaneously. 

Evaluation 

When the plastic fibre optic waveguide (PMMA) is in place, transmission T is generally attenuated due to coupling 
losses but there are also special absorption bands at which transmission breaks down and losses in the fibre are 
severely increased. 

In view of these absorption bands, one can now make a selection of lasers and light emitting diodes which will radiate 
through such a fibre optic waveguide with a minimum of losses. These ranges without specific absorption are also 
called optic windows. The red LED for 660 nm or infrared LED for 950 nm find preferred usage in practical applica-
tions. 

As an advanced experiment, one can cut off a length of about 10 cm fibre optic waveguide for investigation as de-
scribed above. In the ranges of higher absorption this will reveal further details about absorption at 870 and 900 nm 
because this short piece of fibre does not completely absorb these ranges. 

For historic reasons, an energy scale in cm
-1

 is often used in molecular physics. The x-axis units of measure can be 

switched to Wavenumber (1/cm) via  Settings → Additional Settings. 

The C-H bonds in the material are primarily responsible for absorption. The resonant oscillation of hydrogen in C-H 

bonds lies far into the infrared range (about 3,3 µm or 3000 cm
-1

 in methane) but higher order overtones can also be 

generated which lie in the visible and near-infrared ranges. Since this bond represents an anharmonic oscillator, 
overtones are not quite exactly a multiple of the base frequency but rather somewhat less energetic because the 
bond is weaker in the middle. 

The highest energy visible absorption at 625 nm (16 000 cm
-1

) is the 6th overtone of the C-H bond, the others lie at: 

735 nm (13 700 cm
-1

) for the 5th overtone and 890 nm (11 200 cm
-1

) for the 4th overtone. 

Other absorption bands originate from overtones of the O-H bond of diffused water. 

Notes 

Depending on the type of fibre optic waveguide, absorption spectra can be slightly different. 

A different procedure is necessary to perform a precise measurement of fibre optic waveguide losses without cou-
pling losses: the PMMA fibre optic waveguide is fitted with appropriate F-SMA adapters and screw-fastened to the 
fibre holder and the spectrometer. A reference spectrum is recorded with a short piece of fibre (10 cm) and compared 
to a long piece of fibre such that loss differences are only a function of the difference in length. 

Use  Settings → Additional Settings to select the Transmission/Loss display. This will present the fibre's losses in 
dB, the unit of measure used in practical applications. 

In the Transmission, Extinction and Loss displays, only those ranges are evaluated whose intensities in the refer-

ence curve amount to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Reference). 
Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Investigation of Wien's displacement law 

 

Experiment description 

In an incandescent lamp, an electric conductor is heated by an electric current causing it to glow. The emitted spec-
trum is continuous and can be described with Planck's radiation formula. The radiation maximum of the radiation 
shifts with increasing temperature T according to Wien's displacement law 

λmax = 2.9 * 10
-3

 m*K / T 

toward smaller wavelengths; at the same time the maximum value of the radiation increases. At the temperatures 
attained by normal incandescent lamps, about 2300 to 2900 K, the radiation maximum lies in the infrared spectral 
range. Halogen lamps reach a somewhat higher operating temperature of about 3000 K. 

This experiment will record the spectra of a halogen lamp at different power levels. The specification for colour tem-
perature at 12 V nominal voltage allows the wavelength dependency of spectrometer sensitivity to be determined and 
thus permits a corrected display for the course of spectra intensity. Subsequently voltage will be applied to a halogen 
lamp then reduced in steps. The lamp's colour temperature at each voltage step will be determined by adapting a 
suitable fit function. 

Required equipment  

1 Compact spectrometer, physics 467 251 
1 Fibre holder 460 251 
1 Halogen lamp, e.g. 459 032 
1 Power supply, e.g.  521 485 
1 Cable pair, 50 cm, black 501 451 
1 Optical bench, S1 profile, 1 m 460 310 
1 Clamp rider with fixing column 460 313 
1 Clamp rider with clamp 460 311 
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Set up the experiment as shown in the picture. 

Performing the experiment 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Switch on the halogen lamp, set voltage to 12 V. 
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 Adapt the integration time, either directly or with  or , such that maximum intensity lies between 75 % 
and 100 %. Adjust the fibre optic waveguide if necessary. Do not move the lamp or fibre optic waveguide af-
terwards. 

 Switch off the light again to record the background spectrum. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 In  Settings → Additional Settings select the Relative Intensity display and enter the colour temperature 
3000 K. 

 Change to the (now available) Spectrometer sensitivity I2 display. 

 Switch on the halogen lamp again, keep the voltage at 12 V. 

 The displayed spectrum serves as a reference for relative I3 intensity spectra. 

 Change to the Relative Intensity I3 display. 

 Save the spectrum with . 

 Reduce the voltage on the halogen lamp in steps and save a spectrum of each step with . 

Evaluation 

In the Intensity I1 display the halogen lamp exhibits a continuous spectrum with a maximum at about 620 nm. Thus 

the position of the maximum does not correspond to the position for T = 3000 K according to Wien's displacement 

law: λmax = 967 nm. This deviation is caused by spectrometer sensitivity (grey curve), which is not constant for all 

wavelengths. 

If one determines spectrometer sensitivity on the basis of filament temperature then the measured spectra can be 
corrected by this factor. Measured spectrometer sensitivity can be seen in the Spectrometer sensitivity display. It 
has its maximum at 520 nm and drops off substantially toward the range limits. 

In the corrected display, Relative Intensity I3, the incandescent lamp's spectrum shows the expected distribution. 

Intensity increases for increasing wavelength, the maximum lies at about 970 nm. The halogen lamp therefore radi-
ates primarily in the infrared range. 

A comparison of spectra at the various levels of voltage reveals that for decreasing voltage, thus decreasing tem-
perature, the intensity of the spectra diminish. Furthermore, the maximum of spectral distribution shifts out of the 
measured range. By using Diagram → Fit Function → Free Fit it is possible to fit a Planckian radiation curve to the 

spectra. Radiation laws for presentation against wavelength (formula with x
5
) and against energy (formula with x

3
) 

are provided in the formula's selection box f(x,A,B,C,D). The fit will produce values for maximum amplitude (parame-
ter A, initial value 100) and colour temperature in K (parameter B, initial value 3000). According to Wien's displace-

ment law, λmax = 2.9 * 10
-3

 m*K / T, the wavelength can also be calculated with the maximum amplitude. The exam-

ple measurement produces the following results: 

E / V A / % B / K λmax / nm 

12 
99.3 

2994 970 

10 64.9 2750 1055 
8 42.8 2528 1147 
6 20.7 2121 1367 

Notes 

If spectra are displayed as a function of energy rather than of wavelength, the formula with x
3
 must be selected as the 

fit function. Attention! Fits are only valid for the given selected display (wavelength or energy). If the display is subse-
quently changed, the appropriate fit function must again be fit. 

Typical incandescent lamp temperatures by specified nominal power: 

40 W incandescent lamp: 2200 K 
60 W incandescent lamp: 2680 K 
100 W incandescent lamp: 2800 K 
200 W incandescent lamp: 3000 K 
halogen lamp: 3000 K 

In the Relative Intensity display, only those ranges are evaluated whose measurement curve intensity for spec-
trometer sensitivity amounts to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Extinction spectrum of a crystal violet solution 

 

Hazard warning  

Crystal violet is a health hazard and an environmental hazard. Wear protective gloves and goggles. Do not permit 
this material to escape into the environment. 

Experiment description 

This experiment will record the extinction spectrum of a crystal violet solution. Its transmission coefficient and extinc-
tion (optical density) will be calculated. The wavelength of its absorption maximum and the corresponding mean ex-
tinction will be determined. 

Required equipment  

1 Compact spectrometer, complete 467 252 
2 Rectangular cuvettes, e.g. from 664 474 
1 Glass beaker, 100 ml, tall shape  664 137 
1 Volumetric flask, 1000 ml 665 796 
1 Spatula, e.g. 604 5671 
1 Watch glass, e.g. 80 mm  664 154 
1 Scale, 0.0001 g minimum resolution, e.g. OHPA64 
1 PC with Windows 2000/XP/Vista/7/8   

Required chemicals 

1 Crystal violet, e.g. 1 g 672 8560 
  Distilled water   

Required solution  

Prepare crystal violet solution: 0.5*10
-5

 mol/l 

Place the watch glass onto the scale then put exactly 2.0 mg (crystal violet molar-mass: 407.99 g/mol) into the watch 
glass and flush it into the 1000 ml flask with distilled water. Afterwards clean the watch glass, spatula and funnel. 

Experiment setup (see picture) 

Do not place a cuvette in the cuvette holder at the beginning. Do not touch the optical section of cuvettes but 
otherwise clean them well. 
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Performing the experiment 

 Fill one cuvette about ¾ full with the crystal violet solution (sample solution) and another with distilled water (ref-
erence solution). 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Switch on the cuvette holder's lamp with . 

 Adapt the integration time, either directly or with  or , such that maximum intensity lies between 75 % and 
100 %. Do not change the integration time again after this. 

 Insert a black block to record the background spectrum in the cuvette holder. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Remove the black block and insert the cuvette with the reference solution into the cuvette holder. 

 The displayed spectrum serves as a reference spectrum for the following measurements. 

 Change to the Intensity I1, Transmission T or Extinction E display. 

 Insert the cuvette with the crystal violet solution. 

 The light spectrum passing through the crystal violet solution can now be seen in the Intensity I1 display. The 

reference spectrum is also displayed in grey. 

 The crystal violet solution's spectrum relationship to the reference curve is calculated and presented in the 
Transmission T display. 

 Extinction (optical density) will be calculated and presented in the Extinction E display. 

Evaluation 

The crystal violet solution absorbs in the yellow-green spectral range. Blue and red spectral components are 
transmitted. This is what causes the solution's violet colour tone. To determine the wavelength of the absorption 
maximum, a vertical line can be drawn and the wavelength read. The absorption maximum lies by 580 nm. To 
determine average extinction, Define Range for Kinetics can be used to mark a spectral range, e.g. in the ab-

sorption maximum. In an appropriate extinction display instrument (e.g. E580), it is now possible to read out the 
average extinction, that can be used for subsequent evaluations (e.g. calibration curve, kinetics). 

Notes 

In the Transmission and Extinction displays, only those ranges are evaluated whose intensities in the refer-
ence curve amount to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Colour removal from crystal violet with sodium hydroxide 

 

Hazard warning  

Crystal violet is a health hazard and an environmental hazard. Wear protective gloves and goggles. Do not permit 
this material to escape into the environment. 

Sodium hydroxide is caustic! Wear goggles. 

Experiment description 

Crystal violet is a triphenylmethane dye. It dissolves in water and other polar solvents with an intense violet colour. 
Crystal violet is well suited to demonstrate the principles of chemical reaction kinetics. As an unsaturated compound, 

crystal violet supplies additional OH
-
 ions; this causes colour to be removed from the solution. A carbinol base is 

formed, whereby the large-area mesomerism of the molecule responsible for the colouration of crystal violet is inter-
rupted. 

The speed at which this colour removal reaction takes place can be controlled by way of the concentration of OH
-
 

ions. Since the OH
-
 ions present in the solution (about 10

-3
 mol/l) significantly exceed that of crystal violet (5*10

-6
 

mol/l), concentration [OH
-
] changes during the reaction are insignificant, thus the experiment makes a pseudo-first 

order reaction out of a second order reaction. 

This experiment will first record the extinction spectrum of a crystal violet solution. Its transmission coefficient and 
extinction (optical density) will be calculated and displayed contingent to wavelength. The wavelength of its absorp-
tion maximum and the corresponding mean extinction will be determined. The linear dependency of extinction on the 
concentration (Lambert-Beer law) will be shown by the measurement of a concentration series which, at the same 
time, will determine the calibration factor. The investigation of reaction kinetics for removing the colour from crystal 
violet begins by placing a drop of concentrated sodium hydroxide in the cuvette and measuring extinction in the ab-
sorption maximum against time. Based on the previously recorded calibration, the change of concentration will be 
displayed and evaluated. 

Required equipment  

1 Compact spectrometer, complete 467 252 
5 Rectangular cuvettes, e.g. from 664 474 
1 Glass beaker, 100 ml, tall shape  664 137 
1 Volumetric flask, 1000 ml 665 796 
3 Volumetric flask, 100 ml 665 793 
1 Volumetric pipette, 25 ml 665 976 
1 Pipetting ball 666 003 
1 Spatula, e.g. 604 5671 
1 Watch glass, e.g. 80 mm  664 154 
1 Scale, 0.0001 g minimum resolution, e.g. OHPA64 
1 PC with Windows 2000/XP/Vista/7/8   
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Required chemicals 

1 Crystal violet, e.g. 1 g 672 8560 
  Distilled water   

Required solution  

Prepare crystal violet solution: 0.5*10
-5

 mol/l 

Place the watch glass onto the scale then put exactly 2.0 mg (crystal violet molar-mass: 407.99 g/mol) into the watch 
glass and flush it into the 1000 ml flask with distilled water. Afterwards clean the watch glass, spatula and funnel. 

Use the pipette to put 75 ml (0.375 * 10
-5

 mol/l), 50 ml (0.25 * 10
-5

 mol/l) and 25 ml (0.125 * 10
-5

 mol/l) of the 0.5 *10
-5

 

mol/l crystal violet solution into 100 ml volumetric flasks and fill them up to the calibration mark with distilled water. 

Experiment setup (see picture) 

Do not place a cuvette in the cuvette holder at the beginning. Do not touch the optical section of cuvettes but 
otherwise clean them well. 

Performing the experiment 

Measuring the extinction spectrum 

 Fill one cuvette about ¾ full for each of the various crystal violet solutions and another with distilled water (refer-
ence solution). 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Switch on the cuvette holder's lamp with . 

 Adapt the integration time, either directly or with  or , such that maximum intensity lies between 75 % and 
100 %. Do not change the integration time again after this. 

 Insert a black block to record the background spectrum in the cuvette holder. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Remove the black block and insert the cuvette with the reference solution into the cuvette holder. 

 The displayed spectrum serves as a reference spectrum for the following measurements. 

 Transmission for the reference solution in the Transmission T display is 100 % over the entire spectral range. 

 Change to the Extinction E display. Extinction E for the reference solution is 0 over the entire spectral range. 

 Insert a cuvette with crystal violet solution (concentration 0.5 * 10
-5

 mol/l). 

 To determine mean extinction, use the Mark Range for Kinetics option to mark a spectral range about 10 - 15 nm 
wide in the absorption maximum. The mean extinction can now be read from the extinction display instrument 

(e.g. E580). 

Recording the calibration curve 

 Change to the Calibration display. 

 Insert the cuvette with the reference solution into the cuvette holder. 

 After a mouse-click at the appropriate location in the table, enter a value for concentration c = 0 mol/l with the 
keyboard. 

 Enter the corresponding value for extinction into the table or, alternatively, simply drag the display instrument's 
digital display into the table with the mouse (Drag & Drop). 

  One after the other, in order of increasing concentration, determine extinction for each of the crystal violet solu-
tions and enter these extinction values along with their respective concentration into the table. 

 Use Fit Function → Straight Line through Origin to place a straight line through the measured values. The result 
of the evaluation will be used for concentration interpolation that can be displayed in a new display instrument c. 

Removing colour from crystal violet 

 Leave the cuvette with crystal violet solution (concentration 0.5 * 10
-5

 mol/l) in the cuvette holder. 

 Change to the Kinetics display. 

 Use the mouse to drag the tool button for display instrument c into the diagram (Drag & Drop). 

 As simultaneous as possible, activate the  control in the Kinetics menu to start recording the course of concen-
tration c over time and add a drop of sodium hydroxide to the crystal violet solution. 

 Observe the timed course of concentration (depending on NaOH quantity added, from a few minutes up to 15 
minutes). 

 Use the  control in the Kinetics menu to stop the recording for further evaluation. 
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Evaluation 

The crystal violet solution absorbs in the yellow-green spectral range. Blue and red spectral components are 
transmitted. This is what causes the solution's violet colour tone. The absorption maximum lies by 580 nm. 

The extinction of solutions increases linearly for increasing concentrations in the investigated range. Thus the 
Lambert-Beer law is fulfilled. The example produces a linear factor for the 1.0 cm optical distance in the cuvette 

A = 3.817 l/10
-5

 mol. 

If sodium hydroxide is added to the crystal violet solution, the concentration of crystal violet, and thus extinction, 
decreases over time. The decrease occurs exponentially as a pseudo-first order reaction. This can be shown 
by fitting an exponential function to the measurement data (Fit Function → Exponential Function). This example 
produces a 365 s time constant for the addition of a drop of 1 mole sodium hydroxide. 

Notes 

The colour removal reaction is reversible: the colour will build up again by acidifying the carbinol solution. 

In the Transmission and Extinction displays, only those ranges are evaluated whose intensities in the refer-
ence curve amount to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Extinction spectra of food colourings  

 

Experiment description 

Food colourings are a part of many foodstuffs. Food colourings from sweets with coloured coatings can easily be 
isolated for investigation. Colourings consist of conjugated π-electron systems (chromophores) which absorb radia-
tion in the visible electromagnetic wavelength spectrum. Non-absorbed radiation is reflected and becomes visible to 
the human eye as a complementary colour. One differentiates between various chromophore groups: 

 -HC=CH- carbon-carbon double bond (alkenes), 

 -C=O carbonyl groups, carbonyl colourings 

 -N=O nitroso group 

 -N=N- azo group, azo dyes 

To deepen colours, so-called auxochromic groups are used, e.g. -NR2, -OH, -OR, halides because of their mesom-
eric interaction with chromophore groups (expansion of delocalized π-electron system). 

This experiment will record the extinction spectrum of various colouring solutions. Its transmission coefficient and 
extinction (optical density) will be calculated. The wavelength of absorption maximum and corresponding mean ex-
tinction will be determined and compared to the colour impression of the given solution. 

Required equipment  

1 Compact spectrometer, complete 467 252 
2 Rectangular cuvettes, e.g. from 664 474 
1 Glass beaker, 100 ml, tall shape  664 137 
1 Tweezers, e.g. 667 027 
1 PC with Windows 2000/XP/Vista/7/8   

Also necessary 

  Sweets with colour coating, e.g. sugar pearls    
  Distilled water   

Required solution  

Place a number of pearls having the same colour into a glass beaker and cover them with 20 ml of distilled water. 
Sway the beaker to dissolve the colour coating then remove the uncoated rest right away. The white sugar layer 
should not be dissolved in the solution! 

Experiment setup (see picture) 

Do not place a cuvette in the cuvette holder at the beginning. Do not touch the optical section of cuvettes but 
otherwise clean them well. 
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Performing the experiment 

 Fill one cuvette about ¾ full with the colour solution (sample solution) and another with distilled water (reference 
solution). 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Switch on the cuvette holder's lamp with . 

 Adapt the integration time, either directly or with  or , such that maximum intensity lies between 75 % and 
100 %. Do not change the integration time again after this. 

 Insert a black block to record the background spectrum in the cuvette holder. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Remove the black block and insert the cuvette with the reference solution into the cuvette holder. 

 The displayed spectrum serves as a reference spectrum for the following measurements. 

 Change to the Intensity I1, Transmission T or Extinction E display. 

 Insert the cuvette with colour solution. 

 The light spectrum passing through the colour solution can now be seen in the Intensity I1 display. The reference 

spectrum is also displayed in grey. 

 The colour solution's spectrum relationship to the reference curve is calculated and presented in the Transmis-
sion T display. 

 Extinction (optical density) will be calculated and presented in the Extinction E display. 

Evaluation 

Yellow, orange, red, blue and green sugar pearls were investigated in this example. The colour additives speci-
fied on the package were E104 (yellow), E110 (orange), E124 (red) and E131 (blue). All of these colourings 
exhibited transmission in a broad spectral range and absorption (extinction) in a relatively narrow-limited spec-
tral range. For example, transmission for the yellow colouring was over 85 % throughout the 470 - 900 nm 
wavelength range, i.e. in the green, yellow and red spectral range. Therefore it is not only the yellow spectral 
component which contributes to the yellow colour impression but also an overlaying of green and red spectral 
components. Absorption takes place only between 390 - 440 nm, i.e. in the blue spectral range. 

In contrast to the other colours, the colour coating for green sugar pearls contains no special green colouring. 
The respective spectrum shows that a mixture of yellow and blue colouring is used. 

Notes 

In the Transmission and Extinction displays, only those ranges are evaluated whose intensities in the refer-
ence curve amount to at least 2 %. 

The  control can be used to reduce noise by averaging multiple individual spectra (also Offset and Refer-
ence). Alternatively, Smoothing to 1 nm resolution can be set in the settings options. 
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Absorption/reflection of UV light by sun protection agents 

 

Experiment description 

Sun protection agents are rubbed onto the skin to reduce the harmful effects of the sun's radiation (sunburn, blisters, 
skin cancer, etc). Such damage is caused by the absorption of UV light. Therefore sun protection agents are de-
signed to reduce components of sun's radiation in the UV-A range (320 nm - 380 nm) as well as in the UV-B range 
(280 nm - 320 nm). Sun radiation in the UV-C range (100 nm - 280 nm) is typically absorbed by the atmosphere 
(ozone layer) therefore sun protection agents do not need to protect in this range. This experiment will record the 
absorption spectrum of a sun protection agent and investigate its absorption in various ranges of the spectrum. Sun 
radiation will be used as the light source. 

Required equipment  

1 Compact UV spectrometer, physics 467 261 
1 Fibre holder 460 251 
1 Saddle base 300 11 
1 UV permeable carrier, e.g. quartz glass plate 309 07 090 
1 Sun protection agent   
1 PC with Windows 2000/XP/Vista/7/8   

Experiment setup (see picture) 

Direct the fibre holder with fibre optic waveguide toward the sky. Apply a thin coat of the sun protection agent 
as evenly as possible to one half of the quartz glass plate. 

Performing the experiment 

 Activate  to begin a new measurement. 

 Select the Intensity I1 display. 

 Start the measurement with . 

 Adapt the integration time, either directly or with  or , such that maximum intensity lies between 75 % 
and 100 %. Adjust the fibre optic waveguide if necessary. 

 Put a light-tight cover over the fibre optic waveguide's entrance slit to measure the background spectrum. 

 Open the Offset I0 display. 

 The displayed spectrum will be removed from subsequent measurements as the background spectrum. 

 Change to the Reference I2 display. 

 Remove the cover over the fibre optic waveguide's entrance slit. 

 The displayed spectrum serves as a reference spectrum for the following measurement. 

 Select the Intensity I1 display. The reference spectrum is also displayed in grey. 
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 Hold the quartz glass plate with sun protection agent directly in front of the fiber holder and save the spec-
trum with . 

 Also record the spectrum through the quartz glass plate without sun protection agent for comparison pur-
poses. 

 The relationship of spectra to the reference curve is calculated and presented in the Transmission T dis-
play. 

 Extinction (optical density) will be calculated and presented in the Extinction E display. 

Evaluation 

The sun's reference spectrum shows a broad spectral range beginning at about 310 nm, i.e. in the UV-B range. The 
sun's intensity in the UV-B range was quite weak (recording was made at the beginning of December). The quartz 
plate without sun protection agent barely exhibited any absorption at all over the entire spectral range and is there-
fore well suited as a carrier for the sun protection agent. 

Where coated with sun protection agent, the quartz plate shows distinct reduction of intensity. The transmission dis-
play clearly shows that transmission is very low, particularly in the UV-A range. The sun's intensity was too weak to 
further evaluate intensity in the UV-B range. Transmission is even reduced in the visible spectral range. The sun 
protection agent investigated contained titanium dioxide that reflects sunlight over a wide spectral range, even in the 
visible range. This substance is also the reason for the white colouration of the sun protection agent. 

Note 

In the Transmission and Extinction displays, only those ranges are evaluated whose intensities in the reference 
curve amount to at least 2 %. 



  

  
  

  

SpectraLab 
  

 
© by LD DIDACTIC GmbH · Leyboldstrasse 1 · D-50354 Huerth · www.ld-didactic.com 

Tel: +49-2233-604-0 · Fax: +49-2233-604-222 · E-mail: info@ld-didactic.de · Technical alterations reserved 
  

  

49 

Index 

A 

Activation code  8 
Append  10 

B 

Best-fit straight line  14 

C 

Calibration  18 
Clipboard  12, 15 
Color temperature  11 
Compact spectrometer  7 
Coordinates  13 
Crystal violet solution  40, 42 

D 

Delete  12, 15 
Delivery complement  7 
Difference  14 
Display  11 
Distance  14 

E 

Emission lines  32 
Energy saving lamp  34 
Exponential fit  14 
Extinction  17 

F 

Filter  21 
Fit  14 
Flame coloration  30 
Fluorescence  23 
Font size  12, 13 
Food colorings  45 
Fraunhofer  28 
Free Fit  14 

G 

Gas discharge lamps  32 
Gaussians  14 
Grid  13 

H 

Horizontal line  14 
Hyperbola fit  14 

I 

Incandescent lamp  34 
Integral  15 
Integration time  11 
Intensity  17 

K 

Kinetics  14, 16 

L 

Lamp  11 
Light  11 
Line width  13 
Loss  17 

M 

Marker  13 
Mean  11, 14 

O 

Offset  17 
Open  10 
Optical waveguide  36 

P 

Parabola fit  14 
Peak centre  14 
Peak integral  15 
PMMA  36 
Print  10 

R 

Reference  17 
Reflection  26 
Relative intensity  19 

S 

Save  10 
Smoothing  11 
Spectrometer sensitivity  19 
Sun protection agent  47 

T 

Technical data  7 
Text  13 
Time  11 
Transmission  17 



  

SpectraLab 
  

  

  
  

 
© by LD DIDACTIC GmbH · Leyboldstrasse 1 · D-50354 Huerth · www.ld-didactic.com 

Tel: +49-2233-604-0 · Fax: +49-2233-604-222 · E-mail: info@ld-didactic.de · Technical alterations reserved 
  

  

50 

V 

Vertical line  13 

W 

Wien  38 

Z 

Zoom  13 

 


